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Vorbemerkungen
• Die vorliegende Dokumentation gilt dem Erstanwender von OrCAD PSpice. Sie soll weder als Trainingshandbuch noch als vollständige

Bedienungsanleitung verstanden werden.

• Um die Software nutzen zu können, benötigen Sie eine gültige PSpice Designer Lizenz (PO1520) oder Sie verfügen eine gültige 
OrCAD Studenten-Lizenz. Der Schnellstart kann auch mit der OrCAD Trial Version durchgeführt werden.

• Grundkenntnisse in elektronischem Schaltungsentwurf sind hilfreich.

• Aufgrund der Kompaktheit dieser Dokumentation kann nicht auf alle Funktionen und Befehle eingegangen werden. Hierzu ist eine 
umfangreiche Dokumentation innerhalb der Online-Hilfe (Help > PSpice Documentation) vorhanden. 

• Anhand eines einfachen Schaltplans werden die wichtigsten Schritte und Arbeitsweisen mit der Software dargestellt, die es dem
Erstanwender erlauben, mit einem Minimalaufwand an Einarbeitungszeit die ersten eigenen Aufgaben zu bewältigen.

• Nach einer kurzen Einführung in die Benutzeroberfläche und zu den verschiedenen Simulationen beginnt das Training mit der Eingabe 
des Schaltplans ab Seite 30.

• Um loszulegen, entpacken Sie einfach die Datei pspice-demo-22-1.zip in einen Ordner Ihrer Wahl und starten Sie dann die bereits 
installierte OrCAD Capture Software.
− Stellen Sie sicher, dass der Pfadname und der Name des Ordners keine Sonderzeichen oder Leerzeichen enthalten!

• Detaillierte Trainings-Angebote zu den unterschiedlichen Tools finden Sie unter https://www.flowcad.com/de/training.htm

https://www.flowcad.com/de/student-program.htm
https://www.orcad.com/orcad-free-trial
https://www.flowcad.com/de/training.htm
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Capture / PSpice Bedienoberfläche
OrCAD Capture und OrCAD PSpice sind zwei eng miteinander verbundene, aber getrennte Tools, wobei OrCAD Capture verwendet wird, 
um die Schaltung auf einem Stromlaufplan zu entwerfen, einschließlich der Vorbereitung aller von OrCAD PSpice benötigten Eingaben.

OrCAD PSpice selbst ist der Schaltungssimulator, der mit einer komfortablen Benutzeroberfläche zur Anzeige der Simulationsergebnisse 
ausgestattet ist.

OrCAD Capture und OrCAD PSpice sind hauptsächlich menügesteuert.

Gestartet werden alle Capture und PSpice Befehle über:
• Aktionsmenüs (pull-down menu)
• Piktogramme (icons)
• Tastaturkürzel (shortcuts)
• Dialogfenster (pop-up windows)
• Befehlsfenster (Command windows)
• Tcl-Funktionen

Alle Menüs in Capture und PSpice sind kontextabhängig. Das bedeutet, dass je nachdem, welche Elemente, Arbeitsbereiche oder Befehle 
ausgewählt sind, die daraus resultierenden Pop-up-Fenster oder Pull-down-Menüs ihr Aussehen ändern. Es werden daher jeweils nur die 
relevanten Funktionen oder Objekte angezeigt.

Es gelten Einschränkungen bei der Verwendung von Sonderzeichen. Daher wird dringend empfohlen, nur das Unterstreichungszeichen ( _ ) 
als Sonder-/Trennzeichen zu verwenden. Verwenden Sie keine Leerzeichen in Namen!
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Einheiten, Präfix in PSpice
PSpice rechnet nur mit einfachen Zahlenwerten und nicht 
mit Einheiten!

PSpice erkennt folgende Präfix:

1f (femto-) = 1 x 10-15

1p (pico-) = 1 x 10-12

1n (nano-) = 1 x 10-9

1u (micro-) = 1 x 10-6

1mil (mil) = 2,54 x 10-5

1m (milli-) = 1 x 10-3

1K (kilo-) = 1 x 103

1Meg (mega-) = 1 x 106

1G (giga-) = 1 x 109

1T (tera-) = 1 x 1012

Tipp
• Einheiten wie Ohm, Volt, Farad, Henry usw. werden nicht 

berücksichtigt. Sie werden nur zur besseren Lesbarkeit der 
jeweiligen Schaltung verwendet.

• Wird nach einem solchen Maß oder Ausdruck eine Eingabe 
gemacht, so interpretiert PSpice dies als Kommentar.

1KOhm = 1K

• Obwohl Capture Ausdrücke wie 2k2 für die PSpice-Netzliste 
korrekt in 2.2k übersetzt, ist es nicht empfohlen, solche 
Ausdrücke in Ihren Schaltplänen zu verwenden. 
Sie können mit anderen Tools fehlschlagen und andere 
Konventionen verletzen.

Achtung
• PSpice unterscheidet nicht zwischen Groß- und 

Kleinschreibung:
1M = 1m
M und m bedeuten in PSpice jeweils milli (nicht Mega).

• 1 x 106 = 1Meg = 1MEG = 1meg
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Schaltungsbeispiel
• Ziel dieses Schnellstarts ist die Simulation einer vollständigen Schaltung. Als Beispiel dient ein Schaltnetzteil (Switched Mode Power 

Supply, SMPS). Es besteht aus einer Quelle mit Gleichrichter, einer PWM-Steuerung, einem Trafo, einem Tiefpass Filter und einer Last.*

• Im zip-Archiv zum Schnellstart finden Sie einen Ordner Solution, der ein Beispiel für die Simulation der gesamten Schaltung enthält. 
Sie finden dort eine Schaltung mit europäischen Schaltplansymbolen vor. Diese Symbole werden in der Symbol-Bibliothek Europe.olb
zur Verfügung gestellt. 

• Die nächsten Seiten geben einen kurzen Überblick über die notwendigen Aktionen zur Erstellung der Schaltung von Grund auf.

* und der obligatorischen Simulationsbezugsmasse „0“ 
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SMPS-Schaltung – Amerikanische Symbole (Standard)

American Style
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SMPS-Schaltung – Europäische Symbole (Europe.olb)

European Style
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Starten einer PSpice Simulation
Es gibt zwei Möglichkeiten eine PSpice Simulation zu starten:

• Indirekter Start aus OrCAD Capture (bevorzugter Weg, in diesem Tutorial verwendet):
− Starten Sie Capture (Vollversion): Start > Cadence PCB 2022 > Capture CIS 2022

(Testversion): Start > OrCAD Trial > Capture CIS 2022
oder doppelklicken Sie auf das Capture-Symbol, das sich nach der Installation 
auf Ihrem Desktop befindet

− Zunächst wird mit Capture die Schaltung entworfen und das Simulationsprofil erstellt, dann wird die PSpice-Simulation aus der 
Capture-Umgebung heraus über den Run-Button gestartet. Die erforderliche Netzlistenerstellung und Vorbereitung der 
Simulationsbefehle erfolgt im Hintergrund.

• Direkter Start von PSpice:
− Start > Cadence PCB 2022 > PSpice AD 2022
− PSpice benötigt die Netzlistendatei <*.net> und die Schaltungsdatei <*.cir> der zu simulierenden Schaltung. 

Der Nutzer muss sowohl die Netzliste als auch die Befehlsdatei vorbereiten. Was hierfür alles erfolgen muss, geht weit über den 
Zweck dieses Schnellstarts hinaus und wird daher an dieser Stelle nicht weiter erläutert.

• Beginnen wir mit unserem Tutorial.
Starten Sie Capture CIS. Start > Cadence PCB 2022 > Capture CIS 2022 oder Doppelklick
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Starten von Capture
• Die Startseite von Capture zeigt nützliche Informationen,

z.B. die aktuelle Toolversion, Supportinformationen, 
die letzten Projekte, an denen Sie gearbeitet haben, etc.

• Es stehen diverse Demoprojekte zur Verfügung, die mit 
File > Open > Demo Designs geöffnet werden können.
− Zum Schließen eines Demo-Designs klicken Sie einfach

auf das Icon       im Projektmanager.

• Ein bereits bestehendes Projekt wird mit 
File > Open > Project geöffnet.
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Ein neues PSpice Projekt anlegen
• File > New > Project öffnet den Dialog zum Anlegen eines neuen Projekts.

• Im Feld Name wird der Name des neu anzulegenden Projekts eingegeben. 
Geben Sie SMPS ein.

• Das Feld Location zeigt das Verzeichnis, in dem das Projekt gespeichert wird. 
Sie können den Speicherort durch Klicken auf das Icon       auswählen. 
Es wird empfohlen, den Projektnamen auch als Ordnereintrag zu nutzen. Dies hat 
zur Folge, dass alle Projektdaten, die für dieses Simulationsprojekt erzeugt werden, 
in diesem Ordner gespeichert werden, was die Übersichtlichkeit erheblich erhöht. 
Verwenden Sie keine Sonderzeichen (z.B. Umlaute) oder Leerzeichen
für den Ort und für den Namen! 

• Setzen Sie ein Häkchen bei Enable PSpice Simulation.
• Mit OK öffnet sich ein Fenster, welches es ermöglicht ein neues Projekt aus einem 

bestehenden zu generieren. 
Wir starten mit einem leeren Projekt (Create a blank project).

• OK legt das Projekt an.



13FlowCAD Confidential  │

FlowCAD

Projekt SMPS
• Sie haben ein neues Projekt (smps.opj) mit dem Namen SMPS angelegt. In dem Projekt befindet sich das Design smps.dsn.
• Gleichzeitig wurde die erste Seite des Schaltplans (PAGE1) geöffnet, inkl. drawing frame und title block*. Weitere View-Presets sind 

einstellbar.
• Lassen Sie uns kurz einen Blick auf die Ordnerstruktur im linken Panel des Projektmanagers werfen. Indem Sie auf das Icon    klicken, 

klappen die Ordner weiter auf.
• Die Ordnerstruktur ist virtuell, sie existiert nur innerhalb des Projektmanagers. PAGE1, die sich unter Schematic1 befindet, ist nur in der 

Datei smps.dsn enthalten.
• Die Symbole für die Bauteilplatzierung und 

das Verdrahten sind auf der rechten Seite sichtbar.

Auf den folgenden Seiten werden notwendige 
Schritte erläutert, die Sie später bei der 
Erstellung der Schaltung benötigen.

* Ihr title block wird sich unterscheiden, da wir ein 
benutzerdefiniertes Template nutzen.
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• Es gibt mehrere Möglichkeiten, wie man PSpice Komponenten im Entwurf platzieren kann.

• In diesem Tutorial lernen Sie die nachfolgenden Möglichkeiten kennen:

Platzieren von PSpice Komponenten / Bauteilen

Place Part CommandUnified CIS Browser
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Unified Component Information System (CIS) Browser 
• Unified CIS Browser ist ein System zum Verwalten der 

Komponenten mit vorkonfigurierten Datenbanken.

• Ermöglicht das Durchblättern, Betrachten, Suchen und 
Platzieren von Komponenten.

• Sie müssen sich nicht mehr um den Speicherort der 
mitgelieferten PSpice-Bibliotheken kümmern.

• Wählen Sie Place > Component…

• Sie können entweder die PSpice Komponenten 
durchblättern, indem Sie durch Kategorien und 
Unterkategorien gehen …

• Oder Sie können die intuitive Suche verwenden, um Ihre 
Komponenten zu finden.
− Durch die Vorauswahl einer Kategorie oder Unterkategorie 

können Sie die Suchergebnisse eingrenzen.

• Ein Doppelklick auf eine ausgewählte Komponente platziert 
diese im aktuellen Schaltplan.
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Unified CIS mittels Browse
• Kategorie wählen PSpice und Browse

Links: Kategorien-Browser Mitte: Bauteil-Browser Rechts: Eigenschaften-Browser
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Unified CIS mittels Search
• Oder wählen Sie PSpice (oder eine andere Unterkategorie) und geben Sie einen Suchbegriff ein.
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Bauteil platzieren / Automatic Reference Designator
Um Bauteile zu platzieren nutzen wir üblicherweise:

• Place > Part…

• P (Tastatur)

• Place Part Icon

Tipp
Um das Fenster Place Part zu aktivieren, 
müssen Sie zunächst eine Schaltplanseite auswählen.

Wählen Sie unter Options > Preferences, 
im Tab Miscellaneous die Option 
Automatically reference placed parts, 
um die Bauteilreferenzen während des 
Platzierens automatisch zu beschriften.
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Bibliothek zuordnen, Bauteile auswählen und platzieren
Im Place > Part Modus erscheint das Place Part Fenster auf der rechten Seite.

Unter Libraries kann man eine oder mehrere Bibliotheken auswählen. Alle Bauteile in diesen Bibliotheken werden 
in der Scrollbox Part List angezeigt. In das Eingabefeld Part geben Sie das gesuchte Bauteil ein. Dieses 
Eingabefeld dient als einfacher Filter. Hier sind keine Platzhalter erlaubt. Klicken Sie auf eine Zeile in der 
Scrollbox, wird das Bauteil-Feld mit dem ausgewählten Inhalt gefüllt.

Verwenden Sie das Add Library Icon       um Bauteilbibliotheken hinzuzufügen. Die Standardverzeichnisse mit 
PSpice-Symbolen sind:
<installation_dir>\tools\capture\library\pspice
<installation_dir>\tools\capture\library\pspice\advanls

Alle im Fenster Libraries angezeigten Bibliotheken sind in der benutzerspezifischen Datei capture.ini
gespeichert. Bei neuen PSpice-Projekten müssen Sie die Bibliotheken nicht erneut hinzufügen.

Packaging gibt die Anzahl der Bauteile im Package an.

Rechts neben der Vorschau des Symbols zeigen die beiden Icons an, ob dem ausgewählten Bauteil ein PSpice-
Modell       und / oder ein PCB Footprint       zugeordnet ist.

Durch einen Doppelklick auf ein Bauteil in der Liste oder durch Drücken der Eingabetaste in der Bauteilzeile 
kehren Sie zum Schaltplan zurück und können das ausgewählte Bauteil durch Drücken der linken Maustaste 
(LMB) platzieren.

Search for Part ermöglicht die Suche mit Platzhaltern. Vergewissern Sie sich, dass der Pfad korrekt eingegeben 
wurde. Durch einen Klick auf Add wird die Bibliothek zu den aktuell ausgewählten hinzugefügt.
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Verdrahten von Bauteilen, Hinzufügen von Textnotizen u.a.
Nachdem die Bauteile im Schaltplan platziert sind, müssen sie 
verdrahtet werden. Das Verdrahten wird gestartet mit

• Place > Wire

• W (Tastatur)

• Wire Icon

Man kann auch grafische Objekte oder reine Textnotizen 
(z. B. zur Erläuterung Ihrer Schaltung) auf der Schaltplanseite 
platzieren:

• Place > Text

• T (Tastatur)

• Place Text Icon 

Darüber hinaus können auch Bilder oder OleObjects auf einer 
Schaltplanseite platziert werden.



21FlowCAD Confidential  │

FlowCAD

Schaltplan editieren (Net Alias)
• Jede neue Leitung erhält standardmäßig einen vom System 

generierten Netznamen wie z. B. N0001234.

• Diese vom System generierten Netznamen können durch 
Net Alias auf einer Leitung ersetzt werden.

• Innerhalb einer Schaltplanseite werden alle Drähte, Off-
Page-Connectors oder hierarchischen Ports mit demselben 
Namen verbunden, und zwar auch nur durch ihren Namen.
− Sie müssen sie nicht über physische Drähte verbinden (wireless

connection).

Verwenden Sie
• Place > Net Alias
• N (Tastatur)
• Net Alias Icon 

Tipp
Um Netze über mehrere Schaltplanblätter oder sogar Design-
Hierarchien miteinander zu verbinden, müssen Konnektoren 
(Off-Page Connector) oder Verbinder (Hierarchical Port) 
verwendet werden.
Details hierzu finden Sie in der Dokumentation von PSpice.

BusJunction Dot 

Net Alias
Wireless Connection

Unconnected 
part pin
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Tipps für die Simulation
Für die erfolgreiche Simulation einer mit Capture erstellten Schaltung sollte man folgende Dinge beachten:
1. Alle Bauteile müssen mit PSpice-Modellen versehen sein. Wenn Sie Bauteile via Place Part platzieren, stellen Sie sicher, dass Sie 

Bauteile aus der Standard-PSpice-Bibliothek. Sie befinden sich unter:

<install_directory>\tools\capture\library\pspice oder
<install_directory>\tools\capture\library\pspice\advanls

Der Standardpfad mit Capture zeigt auf <install_directory>\tools\capture\library und verwendet Bibliotheken ohne 
angeschlossenes PSpice-Modell!

2. PSpice benötigt ein Referenzpotential mit „0“, um die Simulation durchzuführen. Normalerweise platziert man ein globales Netzsymbol 
„0“          aus der Capsym-Bibliothek und verbindet es mit dem / den Referenznetz(en). 

Verwenden Sie z.B.  Place > PSpice Part… > PSpice Ground um ein solches Symbol zu erhalten.

3. Beginnen Sie mit kleineren Stromkreisen, anstatt mit großen Stromkreisen. 
Unterteilen Sie größere Stromkreise in kleinere Teilstromkreise.

4. Denken Sie nach, bevor Sie ein Simulationsergebnis blindlings akzeptieren. 
Wenden Sie Rule #9* an, bevor Sie eine Simulation durchführen.

* Quelle: Signal Integrity Journal

https://www.signalintegrityjournal.com/blogs/4-eric-bogatin-signal-integrity-journal-technical-editor/post/1539-bogatins-20-rules-for-engineers
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Die verschiedenen Simulationstypen in PSpice
Bevor Sie eine PSpice-Simulation durchführen können, müssen Sie zunächst ein 
Simulationsprofil einrichten. Hier werden die Art der Simulation und alle ihre 
Eingabeparameter festgelegt. 
PSpice unterstützt 4 Grundtypen von Schaltungssimulationen:

• Bias Point (or DC) Analysis
− Statische Analyse, Analyse des Betriebs- und Gleichgewichtspunktes

• DC Sweep
− Mehrfache DC-Analyse mit einem variablen Parameter

• Transient (time domain) Analysis
− Analysiert die Reaktion der Schaltung in Abhängigkeit von der Zeit

• AC Sweep
− Analyse im Frequenzbereich, die zu Amplitude und Phase von Strömen und 

Spannungen führt

Neues Simulationsprofil erstellen

Wahl der Simulation
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Bias Point, DC Analyse
Die Bias-Point-Analyse findet einen Betriebspunkt der 
Schaltung, der als Gleichgewichtspunkt angenommen wird –
Dinge, die sich im Laufe der Zeit nicht ändern (statisch). 

• Statische Spannungs-, Strom- oder Leistungswerte können 
mit PSpice > Bias Points > Enable oder mit den Symbolen 
in der Symbolleiste angezeigt werden: 

• Varianten der DC Analysis
− DC Sensitivity Analysis
− Transfer function (DC gain) analysis

Beispiel
• Projekt bias_point im Ordner 

Solution\Samples\bias_point\bias_point.opj
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DC Sweep
Mit der DC-Sweep-Analyse können Sie eine Quelle (Spannung oder 
Strom), einen globalen Parameter, einen Modellparameter oder die 
Temperatur über einen Wertebereich hinweg variieren (Sweep). Für 
jeden Sweep-Wert wird der Bias-Punkt berechnet.

• Die Ergebnisse werden in der Simulationsausgabedatei (.out) 
gespeichert oder können im Probe grafisch dargestellt werden.

Beispiel
• Projekt DC_Sweep.opj im Ordner Solution\Samples\DC_Sweep
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Time Domain (Transient) Analyse
Bei der transienten Analyse wird die Reaktion einer Schaltung als Funktion der 
Zeit berechnet. PSpice zeigt die Ergebnisse mittels Probe an.  

Für die transiente Analyse muss der Simulator nichtlineare 
Differentialgleichungen im Zeitbereich lösen. Die Ergebnisse sind 
Knotenspannungen und -ströme im Zeitverlauf. Die Visualisierung der 
Ergebnisse im Probe ist wie die Arbeit mit einem Oszilloskop.

Beispiel
• Projekt time_domain.opl im Ordner Solution\Samples\time_domain
• Die Schaltung demonstriert, wie ein Kondensator durch eine periodische 

Impulsquelle über einen Widerstand geladen und entladen wird.

Tipp
• Sie können die Farbeinstellungen des Simulationsausgabefensters unter

Tools > Options ändern. Wählen Sie den Color Settings Tab.

Probe Ergebnis: Ladungsstrom (rot), Kondensatorspannung (grün)
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AC Sweep Analyse
PSpice berechnet das sinusförmige stationäre Kleinsignalverhalten der linearisierten 
Schaltung um den DC-Arbeitspunkt. Die AC-Analyse ist eine Simulation im Frequenzbereich.

Die Ergebnisse sind Spannungen und Ströme, die mit zwei Zahlen dargestellt werden 
können: dem Betrag und der Phase.

Alle Quellen in der Schaltung arbeiten mit Sinuskurven mit der gleichen Frequenz wie das 
Eingangssignal.

Beispiel
• Projekt AC_Sweep.opj im Ordner Solution\Samples\AC_Sweep

Betrag von der Kondensatorspannung über die Frequenz
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Weitere Simulationen
In PSpice gibt es weitere Simulationsmöglichkeiten, die mit den bisher vorgestellten grundlegenden Simulationstypen zusammenhängen:

• Fourier Analyse (Spektralanalyse), als Teil der transienten Analyse

• Temperature Sweep: Sehen Sie die Auswirkungen Ihrer Schaltung in Abhängigkeit von der Temperatur.

• Worst Case und Monte Carlo Analyse: Simulieren Sie die Auswirkungen von Toleranzen und sagen Sie das Yield voraus.

• Sensitivity Analysis: Finden Sie heraus, welche Komponentenwerte einen großen Einfluss auf den Ausgangswert haben. 
Optimieren Sie die Kosten und erhöhen Sie die Qualität Ihres Designs.

• Parametric Sweep: Ändern Sie Parameter der Schaltung und visualisieren Sie deren Auswirkungen.

• Noise Analysis, als Teil der AC-Sweep-Analyse

• Digitale Analysen: Zum Simulieren von Digitalschaltungen.

In diesem Schnellstart werden wir den Parametric Sweep und die Fourier Analyse verwenden.
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Ziele
• Sie werden die in der Einführung gezeigte SMPS-Schaltung entwerfen. In diesem Entwurf wird eine 230 V / 50 Hz-Quelle in einen

5 V DC-Ausgang umgewandelt. 

• In dieser Schaltung wird kein PWM-Controller-IC verwendet. Stattdessen wird ein konstanter Spannungsimpuls von 333 kHz mit einem
Tastverhältnis von 20 % zur Steuerung des MOSFET verwendet.

• Sie werden verschiedene Simulationsprofile definieren und die Ergebnisse im Probefenster mit Hilfe von Markern und zusätzlichen 
Messungen analysieren.

Tipp 1
Die vollständige Schaltung befindet sich im Ordner Solution\Demo_Proposed_Circuit.

Tipp 2
Zum besseren Verständnis der Software wird empfohlen die Schaltung gemäß der Anleitung Schritt für Schritt selbst zu erstellen.
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SMPS Design (I)
• Sie haben bereits das SMPS Projekt angelegt. Falls nicht, finden Sie auf den Seiten 13 und 14 die Beschreibung zum Erstellen eines 

neuen Projekts.

• Falls nicht bereits erfolgt, öffnen Sie PAGE1 des Projekts SMPS in Capture.

• Schauen Sie sich gerne noch einmal die vorhergehenden Seiten an, wenn Sie nicht mehr wissen, wie man nach Bauteilen sucht, wie 
man die Verdrahtung durchführt oder wie man einzelne Werte von Bauteilen ändert.

• Achten Sie darauf, dass alle Bauteile die im Schaltplan spezifizierten Werte erhalten.

• Es gibt zusätzliche Folien, wie man das Coupling Device K1 erstellt und wie man die Parameter einstellt.

• Wenn Sie die übliche Methode zum Platzieren von Bauteilen (Place Part) verwenden, benötigen Sie Bauteile aus den Bibliotheken: 
Infineon.olb, irf.olb, magnetic.olb, PWRMOS.olb, source.olb und special.olb.

• Wenn Sie europäische Schaltplansymbole verwenden möchten, müssen Sie die Datei Europe.olb konfigurieren, die mit diesem Tutorial 
ausgeliefert wird, und sie dann mit dem Befehl Place Part platzieren. 
Sie können die Datei analog.olb verwenden, wenn Sie amerikanische Schaltplansymbole verwenden möchten. 

• Es wird einige zusätzliche Hinweise geben, wie die Schaltung zu gestalten ist.
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Schaltplan SMPS Design (Europäische Symbole)
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Entwurf des Gleichrichters und der Quelle
• Wählen Sie Place > Component… und geben Sie 40EPS08 in das Suchfeld ein. Doppelklicken Sie auf die angezeigte Bauteil:

• Drehen Sie die Diode (R) und platzieren Sie die Diode 4 mal. Drücken Sie ESC, um den Platzierungsmodus zu verlassen.
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Modeling Application zum Platzieren der Sinusquelle
• Verwenden Sie Place > PSpice Part… > Modeling 

Application… oder klicken Sie auf das Icon 

in der PSpice Symbolleiste

• Wählen Sie Independent Sources
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Definieren und Platzieren der Sinusquelle
• Wählen Sie wie abgebildet und geben Sie bei VAMPL 

{Source} und 50 als Frequenz ein. Klicken Sie dann auf 
Place.

• Drehen Sie die Quelle einmal und platzieren Sie sie.
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Bauteile Platzieren aus Europe.olb
• Wir arbeiten mit dem Befehl Place Part für alle Bauteile, die 

nicht mit PSpice ausgeliefert werden.

• Im aktiven Schaltplan drücken Sie P.

• Klicken Sie im Abschnitt Library auf das Icon Add Library

und suchen Sie die Datei 
PSpice_Demo_22_1\Solution\EU_Library\Europe.olb auf 
Ihrer Festplatte. Klicken Sie auf Open.

• Sie finden nun drei Komponenten in der Bauteilliste, aus 
denen Sie wählen können:

• Doppelklicken Sie auf  RES_AD
und platzieren Sie es auf Page1.

• Doppelklicken Sie auf den Text 
RES_AD und ändern Sie 
den Wert auf 0,01.
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Gleichrichter und Quelle fertigstellen
• Platzieren Sie den Kondensator C1 nach der gleichen 

Methode und ändern Sie den Wert auf 1.2 m.

• Wählen Sie Place > PSpice Part… > PSpice Ground und 
platzieren Sie ein 0-Symbol.

• Drücken Sie W um den Wiring Mode aufzurufen.

• Zeichnen Sie alle erforderlichen Verbindungen:
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• Sie sollten nun in der Lage sein, den Rest des Schaltplans 
fertigzustellen, indem Sie die zuvor gezeigten Methoden 
anwenden (außer K1 und PARAMETER).

• Tipp: Die Quelle, die den MOSFET antreibt, ist ein 
unabhängiger Spannungsimpuls.

Fertigstellen des Schaltplans
• Time Period Parameter akzeptiert derzeit keinen 

Ausdruckswert. Als Abhilfe lassen Sie den festen Wert 
stehen und ersetzen den Parameter auf dem Schaltplan, 
indem Sie auf den festen Wert doppelklicken und den 
korrekten {period}-Ausdruck für den Wert eingeben:

• PARAMETER und das K1-Symbol werden als nächstes 
eingefügt.
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Globale Parameter ergänzen
• Platzieren Sie die Induktoren in der richtigen 

Ausrichtung (siehe Punkte).

• Passen Sie alle Werte an das Design an.
Tipp: Die Werte der globalen Parameter werden 
zwischen geschweiften Klammern { } definiert.

• Vergessen Sie nicht, die Netze OUT und FB zu 
beschriften.

• Setzen Sie die Massepunkte an die richtigen Stellen.

• Suchen Sie in Unified CIS nach PARAM, platzieren 
Sie sie auf einer freien Fläche im Schaltplan.

• Doppelklicken Sie auf die Komponente 
PARAMETERS. Der Property Editor öffnet sich:

• Für Wissensdurstige: Prüfen Sie, was Pivot macht.

• Klicken Sie auf New Property.

• Geben Sie den Namen D und den Wert 0.2 ein, prüfen Sie 
die Anzeige (ON / OFF) und klicken Sie auf Apply.

• Wählen Sie Name und Value und klicken Sie auf OK.

• Wiederholen Sie die Schritte für LOAD (50), period (3u), 
Source (230).

• Schließen Sie 
den Property Editor.
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Erstellen des Transformators
Wir bauen einen nichtlinearen Transformator auf der Grundlage des Jiles-
Atherton-Simulationsmodells.

• Suchen Sie in Unified CIS nach dem Core E13_6_6_3C81.

• Doppelklicken Sie auf das einzige Bauteil, das bei der Suche gefunden 
wurde, und platzieren Sie es auf dem Schaltplan. Ein guter Platz wäre über 
den Spulen L1 und L2, aber die Position spielt keine Rolle.

• Doppelklicken Sie auf das platzierte Bauteil im Schaltplan
(Tipp: Doppelklick auf das K).

• Sagen Sie dem Core Modell, dass Sie die Spulen L1 und L2 koppeln wollen.

Tipp
Die Werte der Induktivitäten L1 und L2 beziehen 
sich auf die Anzahl der Windungen in Verbindung 
mit dem für den Transformator verwendeten 
Simulationsmodell.

• Schließen Sie den Property Editor.
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Erstellen des Simulationsprofils
Die Schaltung ist nun vollständig und sollte wie die Referenz aussehen.

Der nächste Schritt ist die Einrichtung eines Simulationsprofils für eine transiente 
Simulation.

• Klicken Sie auf PSpice > New Simulation Profile
oder klicken Sie auf das Icon

• Nennen Sie es transient und klicken Sie auf Create.

Tipp

• Sie können mehr als ein Simulationsprofil für den aktiven Schaltplan erstellen.

• Das Ändern eines aktiven Profils erfolgt über PSpice > Edit > Simulation profile
oder über das Icon
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Simulationsdetails ergänzen
Das Simulation Settings Fenster wird eingeblendet.

• Stellen Sie sicher, dass Time Domain (Transient) als Analyse 
ausgewählt ist. Die Option General Settings sollte vorausgewählt 
sein. Geben Sie als Run to Time 180 ms und als Maximum Step
Size 1 ms ein.

• Klicken Sie auf der linken Seite auf Probe Window und wählen Sie 
during Simulation und All Markers on open schematics als 
Anzeigeoptionen für Probe.

• Drücken Sie OK um das Simulationsprofil zu schließen.

Tipp
• Wenn das Feld Maximum Step size leer gelassen wird, wird ein 

Standardwert von 2 % der Laufzeit verwendet. Die resultierende 
Kurve, die in Probe angezeigt wird, ist möglicherweise nicht exakt 
genug.

• Wenn Sie einen zu kleinen Wert eingeben, erhöhen sich die 
Simulationszeit und die erzeugten Daten.

• Ein angemessener Wert ist etwa 1/1000 der Laufzeit.
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Ausführen der Simulation
• Setzen Sie Spannungsmarker (PSpice > Markers > Voltage Level) oder verwenden Sie 

wie im Bild unten gezeigt (die Farben erscheinen, wenn die Simulation startet).

• Drücken Sie F11, oder klicken Sie       um die Simulation zu starten.

• Wenn die Schaltung korrekt eingegeben wurde, werden Sie sehen, dass sich das Probe-
Fenster öffnet und die Wellenformen für die Knotenspannungen angezeigt werden, 
während die Simulation läuft.

• Ignorieren Sie die Warnung vor einer großen Datendatei, 
die Sie am Ende der Simulation erhalten können 
(die je nach CPU-Typ ca. 2 Minuten dauert).

Note
• Setzen Sie V Marker auf das Netz, I Marker auf den Bauteilpin und W Marker 

auf das Bauteil.
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Simulationsergebnisse: Gleichgerichtete Spannung
• Sie haben bereits 3 Spannungsmarker hinzugefügt:

Blau: die gleichgerichtete Spannung
Rot / Grün: die Spannung an der Wechselstromquelle

• Auswertung:
− Der Speicherkondensator C1 flacht die gleichgerichtete Welle ab, 

der große Wert des Kondensators bewirkt, 
dass die resultierende Wellenform bereits recht flach ist.

Tipp
• Sie können nach der Simulation weitere Spannungsmarker hinzufügen 

oder löschen und die unmittelbare Wirkung im Probe-Fenster sehen.

• In Probe können Sie auch Trace > Add verwenden, 
um die gewünschten Traces anzuzeigen.

• Die Farbzuweisung der Leiterbahnen erfolgt nach einer 
vordefinierten Reihenfolge in der Datei pspice.ini. 
Es kann sein, dass bei Ihnen andere Farben angezeigt werden.
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Strom-Spannungs-Verhalten an C1
Betrachtet man die U-I-Kurven an C1, so sieht man alle 10 ms (100 Hz) Ladestromspitzen und einen hochfrequenten Entladestrom. 
Die relativ flache Spannung ist auf den hohen Kapazitätswert des Kondensators zurückzuführen.

• Löschen Sie die vorherigen Spuren der Wechselstromquelle, indem Sie in unserem Fall die roten und grünen 
Spannungsmarkierungen im Schaltplan entfernen.

• Wählen Sie in Probe Plot > Add Y Axis.

• Trace > Add Trace, oder klicken Sie
Dann klicken Sie auf I(C1).

Tipp
• Wenn der Strom I(C1) in Ihrem Fall negativ ist, 

dann ist Ihr Kondensator C1 um 180° gedreht. 
PSpice misst den positiven Strom von Pin 1 zu Pin 2. 
Wenn Sie C1 drehen, wird das Zeichen 
des Stroms negiert. Dies ist kein Fehler.
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Generieren von HF-Signalen
Der MOSFET wird durch den erzeugten Spannungsimpuls von etwa 330 kHz ein- und ausgeschaltet, wodurch ein HF-Gleichstrom durch L1
fließt und eine HF-Wechselspannung in L2 des Transformators induziert wird. Die Ströme auf der Sekundärseite der Schaltung werden nun 
isoliert und mit den Dioden D5 und D6 (Grün und Rot) in Gleichstrom umgewandelt. Beide Ströme werden in L3 wieder zusammengeführt 
(blaue Kurve).
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Low Pass (LP) Filter
Der Strom durch die Dioden enthält HF-Komponenten. Der LP-Filter sollte diese Komponenten eliminieren. Um dies zu überprüfen, 
vergleichen wir in zwei separaten Diagrammfenstern den Strom durch z. B. D6 und durch den Lastwiderstand R4.

• Schließen Sie Probe und löschen Sie alle Marker im Schaltplan.

• Drücken Sie F12, oder wählen Sie PSpice > View Simulation Results
Probe wird wieder geöffnet, ohne dass ein Plot sichtbar ist.

• Setzen Sie einen Strommarker an der Anode von D6.

• In Probe Plot > Add plot to Window.

• Fügen Sie einen Strommarker an Pin 1 von R4 hinzu.
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Fast Fourier Transformation (FFT)
• Drücken Sie die Schaltfläche FFT in der oberen Symbolleiste:

• Es bleibt nur eine Gleichstrom-
komponente im Strom durch 
die Last übrig (oberes Diagramm).

• Sie werden viele 
HF-Komponenten im Dioden-
strom sehen (unteres Diagramm).
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Ausgangsspannung
• Löschen Sie alle aktuellen Marker im Schaltplan.

• In Probe: Plot > Delete Plot.

• Setzen Sie einen Spannungs-
marker auf die OUT Leitung.

Die Gleichspannung steigt 
oszillierend an, bis sie sich auf 
einen Wert von ca. 5 V stabilisiert 
hat (Einschwingverhalten).
Die Glättung wird durch den 
Kondensator C1 und den 
Tiefpassfilter erreicht.
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https://www.flowcad.com/de/download.htm
https://www.flowcad.com/de/training.htm
https://www.flowcad.com/de/events.htm
https://www.flowcad.com/de/news.htm
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Parametric Sweep, Schritt 1 von 4
Parametric Sweep erlaubt es, eine Quelle (Spannung oder Strom), einen 
globalen Parameter, einen Modellparameter oder die Temperatur über 
einen Wertebereich zu variieren (Sweep). Sie können z. B. eine 
Schaltung mit verschiedenen Komponentenwerten simulieren und die 
Ergebnisse mit einem einzigen Aufruf anzeigen.

Sie haben das Design bereits für einen Parametric Sweep vorbereitet, 
aber erinnern wir uns an die 4 erforderlichen Schritte, um einen globalen 
Parameter zu variieren (als ein Beispiel):

• Schritt 1: Globale Parameter definieren 
− Platzieren Sie das Symbol PARAM irgendwo auf dem Schaltplan.
− Es dient als Platzhalter für die globalen Parameter und definiert 

Standardwerte.

a) Place Part

b) Suche in Unified CIS

Special.olb muss 
konfiguriert werden

Um das PARAM Symbol zu
finden, nutzen Sie eine der 
beiden Möglichkeiten:
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Parametric Sweep, Schritt 2 von 4
• Schritt 2: Ersetzen Sie den festen Gerätewert durch 

einen Parameterwert 
− Doppelklicken Sie auf den Wert des Geräts.
− Ersetzen Sie den Gerätewert durch den definierten 

Parameternamen, schließen Sie ihn in geschweifte 
Klammern { } und klicken Sie auf OK.
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Parametric Sweep, Schritt 3 von 4
• Schritt 3: Globale Parameter im Schaltplan zuweisen 

und anzeigen
− Doppelklicken Sie auf das Schaltplansymbol 

PARAMETER, um den Property Editor zu öffnen.
• Klicken Sie auf New Property.
• Geben Sie den Namen und den Standardwert von 

new property ein.
• Klicken Sie auf Apply (für weitere zu bearbeitende 

Parameter), oder auf OK für den letzten Parameter.
• Wählen Sie in den Display Properties Name und 

Value.
• Bestätigen Sie mit OK.
• Fahren Sie mit allen erforderlichen Parametern fort.

− Schließen Sie den Property Editor.

Nun sind die Parameter definiert und im Schaltplan sichtbar.



55FlowCAD Confidential  │

FlowCAD

Parametric Sweep, Schritt 4 von 4
• Schritt 4: Einrichten eines Simulationsprofils mit aktiviertem 

Parametric Sweep
− Bearbeiten Sie ein vorhandenes Simulationsprofil PSpice > 

Edit Simulation Profile oder klicken Sie auf das Icon
• Stellen Sie den gewünschten Simulationstyp ein: 

hier Time Domain
− Optional: Entfernen Sie in General Settings den Wert 

1m für die maximale Schrittweite (um die erzeugte 
Datenmenge zu reduzieren).

• Wählen Sie Parametric Sweep.
• Setzen Sie die Sweep-Variable auf Global Parameter.
• Setzen Sie den Parameternamen auf LOAD.
• Definieren Sie die Sweep-Werte: Wählen Sie Value List.
• Geben Sie die Werte 10, 50 und 100 durch Leerzeichen 

getrennt ein.
• Klicken Sie auf OK.

− Starten Sie die Simulation mit F11 oder mit Klick auf  
− Wählen Sie ALL und OK im Fenster Available Sections,

das nach der Simulation erscheint.
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Parametric Sweep Ergebnisse (I)
Sie haben ausgewählt, dass alle Sweep-Ergebnisse angezeigt werden, daher sehen Sie 3 verschiedene Kurven in Probe.

Fazit
Eine Änderung des Lastwerts verändert das Einschwingverhalten der Ausgangsspannung.

Tipp
Klicken Sie auf RMB > Trace Information bei einer 
einzelnen Messkurve, um Simulationsdetails 
(wie den Schrittparameter) anzuzeigen.

Plot > Transient öffnet wieder das Fenster 
zur Abschnittsauswahl.

Trace > Cursor > Display oder das Klicken auf 
öffnet den Probe Cursor.

Verwenden Sie die Icons                                           
oder das Untermenü Trace > Cursor, 
um spezifische Abfragen zu einzelnen 
Kurven durchzuführen.
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Parametric Sweep Ergebnisse (II)
• Sie können 2 Cursor gleichzeitig verwenden. Platziert man die Cursor auf verschiedenen Spuren, kann man Messungen auf derselben 

Kurve oder zwischen zwei Kurven durchführen und verschiedene Werte auf der x- und y-Achse anzeigen.

• Verwenden Sie den Cursor 1 mit der linken Maustaste (LMB) und den Cursor 2 mit der rechten Maustaste (RMB), um z. B. die 
Zeitdifferenz zwischen zwei Spitzenwerten einer der Messkurven zu messen.

• Wählen Sie zunächst mit LMB und RMB aus, welche Messkurve Sie messen wollen, 
z. B. die rote. Sie können hier auch verschiedene Messkurven mit LMB oder RMB auswählen.

Max values: 7.5985 V and 5.386 V
Time difference: 54.8 ms

• Sie können den Cursor unter
Tools > Options > Cursor Settings ändern.
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Parametric Sweep Ergebnisse (Messungen)
Sie können auch Messungen an gezeichneten Kurven vornehmen, um die Eigenschaften einer Kurve zu bewerten:

• Klicken Sie auf View > Measurement Results oder auf       . 
Dadurch wird dieses Fenster unter den Simulationsergebnissen angedockt.

• Klicken Sie auf Click here to evaluate a new measurement…
und fügen Sie z. B. max(v(out)) als Trace-Ausdruck hinzu.

Sie können die Messkurve auch erstellen, indem Sie im linken 
Teil auf Max(1) klicken und dann im rechten Teil 
des Fensters V(out) auswählen.

• Klicken Sie auf OK. 
Sie erhalten dann das Messergebnis für jede Messkurve:
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Schlussbemerkungen
• Nachdem Sie die Beispiele in dieser Schnellstart-Anleitung durchgeführt haben, sind Sie nun in der Lage, erste Simulationen mit PSpice 

durchzuführen.

• Dieser Schnellstart soll nur die wichtigsten Schritte aufzeigen, die notwendig sind, um Simulationen mit PSpice durchzuführen.

• Die Schnellstart-Anleitung soll keine PSpice-Schulung ersetzen, wie sie von FlowCAD oder Cadence angeboten wird. Sie ersetzt nicht 
das sorgfältige Studium der umfangreichen Dokumentation, die mit der Software geliefert wird.

• Wenn PSpice-Modelle nicht in der Standardbibliothek zu finden sind, können Sie sich immer direkt an den Hersteller wenden. PSpice 
ermöglicht das Hinzufügen von Modellen in den Simulationseinstellungen des Simulationsprofils unter dem Reiter Configuration Files. 
Darüber hinaus bietet PSpice einen leistungsstarken Modell-Editor, mit dem eigene Modelle auf der Grundlage von Datenblättern erstellt 
werden können.

• Mit PSpice lassen sich auch mechanische oder thermische Elemente simulieren, z.B. ein Stoßdämpfer eines Fahrzeugs oder die 
Temperaturverteilung auf einer Leiterplatte. Für diese Arten der Simulation benötigen Sie nur die elektrischen Ersatzmodelle. Diese sind 
nicht Teil der von Cadence ausgelieferten Standardbibliotheken.

• PSpice kann mit digitalen und analogen Signalen umgehen, die in derselben Schaltung koexistieren, indem eine digitale 
(ereignisgesteuerte) und eine analoge Simulation zur gleichen Zeit ausgeführt werden.

• Mit der Smoke-Analyse kann PSpice überprüfen, ob Ihre Komponenten unterhalb ihrer maximalen Betriebsbedingungen eingesetzt 
werden. PSpice identifiziert belastete Komponenten und verbessert die Zuverlässigkeit der Schaltung.
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PSpice Erweiterungen
• PSpice ist nicht nur ein analog / digital Simulator, sondern dient auch als Werkzeug um die Leistungsfähigkeit, Zuverlässigkeit,

Produktivität, Machbarkeit, Kosten und Qualität von Schaltungen zu verbessern. Dies geschieht z.B. mittels Einsatz der Sensitivity 
Analysis, Parametric Plots, Monte Carlo Analysis, Langzeit-Zuverlässigkeitsanalyse (Smoke) und durch Optimierung mit der PSpice 
Advanced Analysis Option.

• PSpice erlaubt die Simulation auf Systemebene aufgrund der Eigenschaft die Funktionalität von Mikrokontrollern, Mikroprozessoren über 
abstrakte Modelle in C/C++, SystemC und VerilogA abzubilden. In Kombination mit der akkuraten analogen und Mixed-Signal Simulation 
ist es möglich, ein gesamtes System inklusive aller Algorithmen in einer Plattform zu simulieren.

• Eine weitere Anwendungsmöglichkeit besteht darin, dass PSpice mit MATLAB verbunden werden kann. Cadence stellt einen 
modifizierbaren Programmieradapter (SLPS, Simulink-PSpice) zur Verfügung. Dieser erlaubt eine Co-Simulation mit MATLAB sowie eine 
Nachverarbeitung von PSpice Daten durch MATLAB. Außerdem können MATLAB Block Funktionen in der PSpice Umgebung genutzt 
werden.
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Anhang
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Systemvoraussetzungen
Betriebssystem Windows 11 Professional und Enterprise;

Windows 10 (64-bit) Professional and Enterprise, including Dark Theme mode
Windows Server 2016 (All Service Packs)
Windows Server 2019

Empfohlene Hardware Intel Core™ i7 4.30 GHz or AMD Ryzen™ 7 4.30 GHz with at least 4 cores
16 GB RAM
50 GB free disk space (SSD recommended)
1920 x 1200 display resolution with true color (at least 32-bit color)
A dedicated graphics card supporting OpenGL, min 2 GB (with additional support for DX11 for 3D canvas)
Broadband Internet connection for some services

Generell Die oben genannten Angaben zu Hardware sind als Mindestanforderungen zu verstehen. 
Je nach gestellter Aufgabe muss die Hardware entsprechend „nach oben“ angepasst werden. 
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Installation
• Um dieses Tutorial erfolgreich durchführen zu können, wird vorausgesetzt, dass die Software korrekt auf Ihrem Rechner installiert ist und 

Sie Zugriff auf Ihre PSpice-Lizenz haben.

• Alternativ haben Sie die OrCAD Trial Version 22.1 installiert und aktiviert.

• Eine Installationsanleitung für die Software finden Sie unter https://www.flowcad.com/de/download.htm.

• Dieses Tutorial basiert auf der Software Version SPB 22.1.
− Es funktioniert auch mit früheren Versionen der Software, aber Sie werden in einigen Screenshots Unterschiede feststellen.

https://www.flowcad.com/de/download.htm
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Please do not hesitate to contact us.
Für weitere Fragen und Informationen stehen wir gerne zur Verfügung.

FlowCAD Deutschland
Mozartstr. 2
85622 Feldkirchen bei München
T +49 89 45637-770
info@FlowCAD.de

FlowCAD Schweiz
Hintermättlistr. 1
5506 Mägenwil
T +41 56 485 91 91
info@FlowCAD.ch

FlowCAD Polska
ul. Sąsiedzka 2A
80-298 Gdańsk
T +48 58 727 90 90
info@FlowCAD.pl 

Contact us / Kontakt zu FlowCAD 
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Follow Us

Don’t forget to subscribe, share and like! 

» FlowCAD.com » youtube.com/
FlowCAD

» FlowCAD.com/
newsletter

» linkedin.com/
FlowCAD

» facebook.com/
FlowCAD

» twitter.com/
FlowCAD

» instagram.com/
FlowCAD

» xing.com/
FlowCAD

http://www.twitter.com/FlowCAD
http://www.youtube.com/FlowCAD
http://www.facebook.com/FlowCAD
https://www.xing.com/companies/flowcadeda-softwarevertriebsgmbh
https://www.flowcad.com/
https://news.flowcad.ch/?p=subscribe&id=3
https://www.linkedin.com/company/flowcad/
https://www.instagram.com/flowcad.eda/
https://www.flowcad.com/de/index.htm
http://www.youtube.com/FlowCAD
http://www.youtube.com/FlowCAD
https://news.flowcad.ch/?p=subscribe&id=3
https://news.flowcad.ch/?p=subscribe&id=3
https://www.linkedin.com/company/flowcad/
https://www.linkedin.com/company/flowcad/
http://www.facebook.com/FlowCAD
http://www.facebook.com/FlowCAD
http://www.twitter.com/FlowCAD
http://www.twitter.com/FlowCAD
https://www.instagram.com/flowcad.eda/
https://www.instagram.com/flowcad.eda/
https://www.xing.com/companies/flowcadeda-softwarevertriebsgmbh
https://www.xing.com/companies/flowcadeda-softwarevertriebsgmbh
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